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. » Computer » Local Disk (D) » Songs » Music and NewAge » [nys Albums » 01-Watermark 1968

v 01-Watermark 1988 cary v Share with v

Enya Albums Nacie ontributing artists  Album

Music and NewAge

9] 01-Watermark.mp3 y

Sonas 14 02 Cursum Perficio.... y
Local Disk (D:) 4 03-On Your Shore.... nya
Computer |4 04-Storms In Africa.... nya
2] 05-Exilemp3 ya

£ Documents 2] 06-Miss Clare Reme... nya
& Music 4 07-Orinoco Flow.m... nya
) Pictures 2] 08-Evening Fallz.mp3 ya
8 Videos 2 09-River.mp3 nya
4 10-The Longships... nya
8 Compter 3] 11-Na Laetha Geal . nya

& Local Disk (C)
# Local Disk (D)

€ Network
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D 3 &t -
Organize » (3 Ploy o u;.\l\ C._il_u = . @
A Favorites ‘ 05-A Day Without Rain 2000 Date modfied: 6/17/201112:52 AM
I Desktop D:\Songs\Music and NewAge\Enya Albums
Do A 07 One Day - Ace Of Base Alburn: The Golden Retio Length: 000303
= Recent Places Ace Of Base Genre Pop Sue 285MB
B Libisies B YouTube - HR Pufnstuf_limmys b_day Pt 3 of 3 Date moddied: 4/8/20108:32 AM
T i D:\Funny Items\H R Putnetut pe Windows Media Player Sie 206 MB
4 Documents
o Music & YouTube - H R Pufnstuf_Jimmys B_day Pt 2 of 3 Date modified: 4/8/20108:20 AM
& Pictures D:\Funny ltems\H R Pufnstuf Type: Windows Media Player Sze 136 MB
B Videos B YouTube - H R Pufnstuf Jimmys B day Pt1of 3 Uate moditied: 4/8/2010 8:20 AM
D:\Funny ltems\H R Pufnstuf Type: Windows Media Player Sze 139 MB
1™ Computer
: A _day_in_stunt_city ight: 240 Date modificd: 4/11/2000 1208 PM
1 Dick (C: ST e N . ,
s Local Dk 0y & Length: 000100 idth: 320 Sze 131 MB
¢ Local Disk (D:)
) The_day_before_you_came Album: The Definitive Collection (Dis Lenath: 0005:51
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() Open ) biwai < Lelaids o glladll

File » Open... Ctr+0
View » Open URL.. CuleU raMd
x Play Save as
B Library Playlists Tooks » Close CtrleW
a3 P
laylists Help » ST
»| Untitled playlist »
" Show menu bar CtrleM
4 Jd Music
Q, Adist Untitled playlist
©) Album >
© Genre Manage libraries »
[ Videos
<) Pictures Properties
# Recorded TV Work offline
Exit
¥ Other Libraries

“ Media Guide +
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ohasdl A gl ) Jga sl | padiiall Gy Ly s gll cilalae) 5 edaa yuail Control Panel s ksl da fl aadiis
dagl A mes o dyglalls A0l 33U ela (3 )kl 4 5l) Control Panel < (1u)) Start 4as
sl

4 » Costrol Pasel » A8 Contecl Pane ems » « | 43 [ Socxh Cortref Pasa 2

Adjust your computer’s settings

r Action Center

S Coloc Management
s Device Manager

h Fonts

<> Keyboard

E Notification Area lcons
" Power Options

@ sound

[ Troubleshooting

Ty Windows Mobility Centee

§7 Administrative Tools
@ Credential Manager
et Oevices and Printers
T‘ Getting Started

R Location and Other
4 Sensors

& Parental Controls

f\f Programs and Features

) Speech Recognition

8 v rccouns

&) windows updste

2 AutoPlay

i

27 Date and Time

. Display

Q) HomeGroup

g Mail

. Pecformance Information
and Tools

M Recovery

®) synccener

a Windows CardSpace

% @adkup and Restore
© oetoutprograms
@ Ease of Access Center
J Indexing Options
P mouse

g rersonaiization

B Region and Language
B system

884 viindows Defender

Viewby: Lugeicons =

<& sittocker Drive Encryption
BB Destrop Gadgets
"A Folder Options

@ tntemet Options

Network and Sharing
Center

a Phone and Modem
ol RemoteApp and Desktop
W Connections
| Taskbar and Start Menu
‘ Windows Firewall

Date and 4V e a1l LS gl 5 g Ul sl aadiud o(<dsll 5 & )4ll) Date and Time
AUl 3380 jedain Time

Set the date and time:
Date:
< August, 2011

Su Mo Tu We Th
AT Z 3 8
7 8 91001
14 15 16 17 18
21 2 3 85
2 29 30 31 1
4 5 6 7 8

Time:

-
4

-

\DluaONw
swBsar .

EEELU:
L.IA ‘.}A C._‘S‘,“J @Juh HS va.' u. -

Change calendar settings

oK

| [ Concel]

i sl / ) e il el

Get more time zone information online

How do [ set the clock and time zone?

Time zone

(UTC+03:00) Baghdad

There are no upcoming Daylight Saving Time cl

Date:
Saturday, August 20, 2011

Time:
2:2342PM

# Change date and time...

/.Ls._x

)

a0

| ]

Lo J( o )
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e g delally
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Liliala 5 dpnlall il S JS g pat Al Alaad JLAT) 138 a0d%y o( 3 ¢aY) ) Device Manager

e Ly g sny G Aadadl) el (1) Gani dadle 5 i pee il dakadll Hlal (%) algivd Aadle ey G

File Action View Help

@@ dmle

4 Dawood-PC
» 3@ Batteries
» {8 Computer
» = Disk drives
» Mg Display adapters
» 4 DVD/CD-ROM drives
» @5 Human Interface Devices
1 g IDE ATA/ATAPI controllers
»- @ IEEE 1394 Bus host controllers
» 25 Imaging devices
» &= Keyboards
5 -/ Mice and other pointing devices
» I Monitors
» & Network adapters
4[5 Other devices

[l Base System Device

|l Base System Device

[ l5) Base System Device

|| Fingerprint Sensor

‘ &) Unknown device
» [ Processors
» 88 SD host adapters
b -4 Sound, video and game controllers
1 M System devices
b @ Universal Serial Bus controllers

-

i) die) Audall 4o il Aagtall daat aihasd o &5 o Dlagall 5 3 3¢aY)) Devices and printers

(Dlantal) ciiliall Aa o) e glall Jia) Apalally Ada g yall 40 Hlal) 3 jea¥) afa Aadiall (a jai (Aasldal)
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~ | 4 [ Scarch Devices and Prnters »

%5 » Control Panel » All Control Panel ltems » Devices and Prnters »

x

Add adevice  Add a printer
Winds display . Chick to change...

USB Composite USRTnput Device  LISB OPTICAL
Device MOUSE

4 Devices (5)

DAWOOD-PC  LaplopInteyrate
d_Webcam M

4 Printers and Faxes (5)

oD

Adobe PDF Fax HP Reskjet F2200 | Microsoft Office Micsosoft XPS
i Document Image  Document Wiites
Wiiter
4 Unspecified (1)

jﬂ < lele Sdgal) a5 AN Aadlall st oy
4 Set as a default printer < (e 5 )3
(At y AaglaS Zaglhal) 038 (uat)

i) i) ae Jaladll o4 435830 03] ddia aal :(Jawdl @l jLa) Folder Options e
:(Hidden Files)
(u=ibad) < Properties sclial cislhaall paiall (368 (par 385 :alles (2 3l Hidden 83« paic Jaal v
(s33%) Hidden 4dS ol v/ ddle aa <

General | PDF [Daaislpmvm]

Soertiic Stes_ Universy of Baghdad

Adobe Acrobat Document (pdf)

D:\Technical
951 KB (974,034 bytes)
952 KB (974,848 bytes)

Friday. June 17, 2011, 12:59:39 AM
Thursday, February 24, 2011, 8:43:18 PM
Friday, June 17, 2011, 12:59:39 AM

(s Readong; (7] Hidden

o il | / it oot ] it il catels (12)
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< (U=e) View Asda I Jasl < 5 )kl 3a 1 8 Folder Options 4S8y &) ; 4ddall paliall jley v
Ol s il ,ell) Hide hidden Files, Folders, and drives shwll sl v 4dle 4l 5L A8
(il S adll

General | View | Search
Folder views

You can apply the view (such as Details or Icons) that
you are using for this folder to all folders of this type.

Advanced settings:
.. Files and Folders
[] Always show icons, never thumbnais
[] Aways show menus
Display file icon on thumbnais
Display file size information in folder tips
[] Display the full path in the title bar {Classic theme only)
1. Hidden files and folders
@ Dont show hidden files, folders. or drives

© Show hidden files. folders. and drives
T>D Hide empty drives in the Computer folder
¥

Hide extensions for known file types
[¥] Hide protected operating system fies (Recommended) ~

ok ) [cmet ) (o ]|

Agale LS Lgna Jalail) ¢Say (1 colial JSEIL i o LS ilanin S Apidal) jualinll jglaid

L) clalall jledaly Wl i sdgalall ANl N pualinl) pla i s £liaY) dda oY v/

Hidden &S sl (10 v/ Adle sl < yuaial) Lo (uar 8 580 < o3le 7 5 e LS
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Aalall o doaiall gal ) A5 o3a aaiiud 1 cildaall s mal ill) Programs and Features e
Install cuadll dddes ol jal g Lail 5 (Gualll 5 Faill ddas) g dpulall o Ll (S0 ¥ Qa5 mal Jll o) v
Axmia ) geay daalll 5l zalijll Jasnd
<Auto Run Ul Jadill dadia e 4y 5all al 81 8580 Clgll 1 8 Al Conssal Cupnaiil) dlae o) v
e (5923 AL dadia 78 21d CD drive A siadl) al 81 & jae (sd (il Jaal padiuall GG Saa
(W) Next L) sl (csai) Install L3

e DVD RW Drive (E:) THE DARK SIDE |
H SEDRA

[7] Always do this for software and games:

Install or run program from your media

oaall sl Jaedall jlaal)

Run setup.exe
Publisher not specified

General options

Open folder to view files
» using Windows Explorer

p

F.EAR. 3 - InstallShield Wizard

Welcome to the InstallShield Wizard for FEAR. 3

The InstallShield Wizard will install F.E A R. 3 on your computer. To continue, click Next.

Gl sl | ittt e sl el (14)
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& LS cUninstall "ceatill sl dlee o) ja) cany ddaalal) Lg Auaidl GA“)..\M el v

Al 320l Helati < 3 Havudl As = (auml\} C.A\),\S\) Programs and Features S e A g0 a5 8

Programs

Cemtrol Panel Home

Uninstall or change a program
View witaled uptates

% T Windows featuses on o

o Orgence =
Neme

O Adsbe AR
(R Adobe Flash Player 10 ActveX
[ Adabe Photoshop €4

# Apple Apphiation Suppoct

#9 Acple Softmare Update

7 Ashampoo Buming Studo 5.0

03 Microsoh Office Enterprine 2007
QresPioye

R Skype Teomers

Qsype~a2

[winZp 120

o Yahos! Mestenger

&7 Currently installed programs Tees

k\‘

T Unenstall o program, sefect & from the bst and then chck Uninstall Change. o Fepas.

Publcsher

Adsbe Acrcbat § Professional - Arabic. [nghoh, Mebr_.  Adobe Syvterm

Adobe Syztem inc
Lanbe Systems Incerpeented
Agobe bystems cerpesned
Appiednc

Apple bnc.

#shamgos GmbH & Co.KG

BTMCAS Shudy Gusde 20T Microsofht Office System (A MiciosoRt Presy

Skype Technologies SA
Sype Technclogies 4
WinZip Cemputiog, 1.

= 139GB

Instaled Oa  Sie

/o270
sa1201
yaEm
101
61772011
s
Lo
1120
62011
myvan
v
e
sa120m

Veruen
908
1105990
COOME 1015388
a6 uo
»NEM8 124
2I5MB 213118
905
vIMe 20030
12064255000

S3ME 1040
nIME 423
une

Al e el 52 (cuatil) slall) Uninstall L) biail s ayeaii sl o glhall mabill e 33l 5 50 il

£ » Control Panel » Al Control Panel fems.

rograms and Features

rol Panel "
Conrel PanalHaret Uninstall or change a proge;

View instaled updates To urnstall s program, seect
& Tom Windows festures on or
2 Organize »  Uninstall
Neme
J- Adobe Acrobat Professionsl -

sl o sllaall uali il

Uninstall ) J8 & 4pais

Adobe Systems Inc. Product version: 110.5790

£ Adobe AR
0 Adobe Flash Player 10 ActiveX Adobe Systems Incorporated  6/17/2011 600M8 1045364

18 Adebe Photoshop CS4 Adobe Systems Incorporated  7/27/2011 1268 10

9 Appie Application Support Apple Inc. /177201 NEME 121

) Apple Software Update Applelnc. smn 215M8 21116

* 7 Ashampoe Burning Studie 905 ashampoo GmbH & Co. KG sa201 205
®IMCAS Study Guide: 2007 Microsoft Office System Edi...  Microsoft Press 892011 8aM8 20010

©3 Microsoft Office Enterprise 2007 Microscft Corporation s 12064251000
Qrealayer RealNetworks 86201

3 Skype Toolbars Skype Technologies SA. 8137201 SI6MB 104051
Qsiype™ 42 Skype Technologies SA. 813201 NIME 4216
DwinZip 120 WinZip Computing, .. 8200 HIME 120805

& Yahoo! Messenger 6177201
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[English (United States)

Date and time formats

Short date:
Long date:
Short time:

Long time:

[Mrdryyyy

dddd, MMMM dd, yyyy.

Al lsal

[hemm ¢t

sl

[ eemmss

First day of week:  [Sunday
What does the notation mean?

Examples

Short date:
Long date:
Short time:

Long time:

slasiul

8/20/2011
Saturday, August 20, 2011
6:49 PM

6:49:45 PM

i
&oul

< 3kl da o) (e (45l 5 dakidl) Region and Language 4558y il (4w jdll Sie) saas 45l ALy

o8 addiui ;( 4allly 4dhidl) Region and Language
Ao sl s sl A e 5 Dia) Gl S5 sl 435SV

el s Gl (6 Al ARl AdlnY Gl a5 ¢ (&L
Region and Language 4S8 _ail g Ul daua jpsdl v/
D5 0% T daiaa o < 8okl a5l e (45115 Haaial)
S WS cFormat 2aild A A gl sl uats A gal) s Zapall
Arabic (Saudi sl Gk oo goad) mEll Jysail
Arabia)

_wad) Change Keyboards L&l ((<@lallly ~alaall Sla o) Keyboards and Languages 4aia (s

dalll Al 218 «OK L) 3l < (A All) French 4alll pal < (ddla)) Add L) L8 < (miliall 4l

:(Task barsleall Jay yi 8) 838Ul (e Jaul GBS A el A0 ) Al

[ Fomats [ Location | Languages | &

|

Keyboards and other input langua

How do | change the keyboard |

i ges g
Tu change your keybuard ot inpul language click Chianige keybuerds. i
Change keyboards... 3

Dicplay language

Install
where supported recognize speech and handwriting.

o il | / it oot ] it il catels

for the Welcome screen? -
ooty tot ang| = TR Senvces and it Languages #
General | Language Bar 92| =
[ oy
St e b ot e o o e o o 2
Englieh (Unted Statee) - US -
Add
nstaled services
Usethe : : oK
A E1US Englsh Table for M Arabc 28
W s | oo
5 Keyboard ‘ 5 Enclsh Gmbobwe)
e e =
B Endish (Unted Siates) & Farosce (Faroe Icnde)
& Koo Y | & e ionc
- us T Renod] | ® revish (uiand B
- Prench (Beigum)
Fropedief | o trench (canade)
& French (France)
voe Wl | & Keyboard
vl
Flshow Moce....
®
0K Cancel @ Fremh (Swilesrla)
@ Frisan (etherande)
b (e ———
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JS (Sl saal gl el 8 axditis (e ST Glia oL (S o oaeddinall Gllua) User Accounts e
Uy LSl s Sy IS5 ccliloal) ) Jsaall o 3 Jae (S5 daaladl ailalae) Jle Jaal) padid
cllal) (e g )il G aa g L Aadally Cuall (paniiondl)

Ll o 3al IS () J s gl 5 Amidall aladial g el all cunali olal) / cunali 3a 41 :Administrators ¢\ .1
gl e Opeadiuall gy e i e oLl Al 8 AV GuplaY) Gaeadiuall Hull A6 e ) gad) S

L“g‘)by‘

Sl m Y le Lwlall Glalae) puad g debdall g aal il Qe aladiul 3a 4l :Standard User ple padiue 2
el canat dl) [t aa Y s AV Clilual) 4l
ey ¥ anlall @lblae) e sl Lasd Vs delhall e Al Gadd el el aladin) a4l :Guest <kl 3

o) uali oa) [

ia gl < (Q;uqsl.ul\ <blea) User Accounts 48 e ERTAENIIEN Sla /‘éJLﬂ\ Glual) Gilalae) el v
Al 32d0l et 3 ylavll

- All Control Panel Items » User Accounts v %9 M Search Control Panel el
- B

Make changes to your user account

k_lLuzA.“ 3 ) g il Create a password for your account z =
[T Change your picture ‘E Dawood

u K ommc 105 o ini

i /¥ Change your account name | ACINOETETO)
ul.u;l\ \:a.\i:!.uu ‘u.n\ )g;uj 4 Change your account type

/ EPEEPREG VO B

m oS opehes % MBnage another account

| VN ] ?35 Nentia \"N‘ );l;\ﬁ & Change User Account Control settings

See also

% Parental Controls
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Keyboard ShortCuts i i xuial da 5l el jaisa 45

a5 (s skall) aSaill 3131 aladiud e Liase cllladll (e 58S ) jaY zuiliall da o) alasin) (Ko
de gane 8 2l 3N i) Sl daasd)l W) e da ol 3 L8S 50  (Enter) JaaY) plid v
(ebdal) die s J5 3l f) < sl
(e bl ie Sl g ) @l sV o Jiall adis WD € clalaiyl mlie v/

(Aebkal) die Allkaal) LY prasal }i) Delete gl el (A8 () Delete zls v/

el e A8 sl pai 6) (Back) (& gl (A €& (Back Space) ¢!l mudl #lide v
(ebdall xie

[(Start) Tl 4as il i o (B sl Flie v

cioall debda J A dgle ekl die 4 30KV (g all s ) Axuall deliday o gy 1(Jasadll) Shift b

LAY Cagoall JS el o a5 3 e 4dde Lol ie o((3_usll Cagall cuil) Caps Lock gl

Al o agle il JLERYI 138 clalY G Sl Aapeall

<X

Acliball die dadiall 4yl ) dsall Jiy (d0lall) Home zlis
LB liall dn gl (aa 83 5 sall 1Y) Jerdi gle Jazuall sie (ol ,Y) & 5) Num Lock e
A SV 5 A pall L LD (0 o a3 1 Alt+Shift

el () AU o) Jis 2 (el dga 8 4281 1) Ctrl+Shift
Dbl (UK alat) J83 2 () dga 8 480 lI) Ctrl+Shift
Asdall & jpaliall ;s L) 1(Select All) Ctri+A
B4l jpaliall & 1 (Copy) Ctri+C

B22aall jualiall (28 :(Cut) Ctri+X

Aa paiall g AA puiall paliall (3ual 1 (Paste) Ctri+V
) e sl ¢34 1 (save) Crl+S

Anlall e~ scaal atudl el ;(Aelb) Ctrl+P

Baeludl dadia =% 1 (Help) F1

) cale sl Jaae3 1 (Rename) F2

Al e 3 ) sall ad gisale) 1 (Refresh) F5
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